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Chapter 1: ScreenWorks Software Version 5.1.7 Release
Notes

The version 5.1.7 update is a minor release. Included are a summary and details of the changes
incorporated in this revision as compared to version 5.1.4, the last general release of the
software.

The following topics are included in this chapter:

ScreenWorks Software Version 5.1.7 Summary, see below
Issues Addressed in ScreenWorks Software v5.1.7, see below

For computer requirements, software update instructions, and other related details, see
ScreenWorks Software General Information on page 31.

ScreenWorks Software Version 5.1.7 Summary

The version 5.1.7 update incorporates the following changes:

Tracking ID Status Functional Area Description

SW51-207 Modified Instrument Added support for new Thermo Chiller

SW51-75 Fixed General Misleading camera stabilizing message

SW51-200 Fixed Peak Pro 2 Analysis In exported data, wells with 0 value show as blank

SW51-201 Fixed Peak Pro 2 Analysis Clicking on different wells does not refresh the detail graph

view

SW51-202 Fixed Peak Pro 2 Analysis After editing measurement values, user cannot move and

adjust the horizontal lines

SW51-204 Fixed Automation If renaming data files in automation fails, the data is lost

SW51-205 Fixed Data Corrections Subtract Background in Data Corrections produces incorrect

traces

Table 1-1: Summary of version 5.1.7 changes

Issues Addressed in ScreenWorks Software v5.1.7

The following explains the issues addressed and fixed in version 5.1.7.

Added support for new Thermo Chiller

SW51-207

ScreenWorks is updated to support the EDGE Thermo Chiller.

Misleading camera stabilizing message

SW51-75

When user selects not to stabilize the camera, the status message incorrectly states that the
camera is being stabilized.

1
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In exported data, wells with 0 value show as blank

SW51-200

If a value in PeakPro 2 Analysis is zero, the exported data incorrectly shows it as blank.

Clicking on different wells does not refresh the detail graph view

SW51-201

In PeakPro 2 Analysis, the detailed graph and the associated settings are not updated when
user clicks on different wells.

After editing measurement values, user cannot move and adjust the horizontal
lines

SW51-202

After editing measurement values in PeakPro 2 Analysis, the horizontal lines cannot be moved
or adjusted by mouse.

If renaming data files in automation fails, the data is lost

SW51-204

In Automation Mode with barcode option enabled, if the path to where the data file is saved is
very long, ScreenWorks may fail to save the data file.

Subtract Background in Data Corrections produces incorrect traces

SW51-205

ScreenWorks may produce incorrect graph when in data correction, users selects Negative
control correction, Response-over-baseline and Subtract background.
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Chapter 2: ScreenWorks Software Version 5.1.4 Release
Notes

The version 5.1.4 update is a minor release. Included are a summary and details of the changes
incorporated in this revision as compared to version 5.1.3, the last general release of the
software.

The following topics are included in this chapter:

ScreenWorks Software Version 5.1.4 Summary
Issues Addressed in ScreenWorks Software v5.1.4
Known Issues in ScreenWorks Software v5.1.4 on page 9

For computer requirements, software update instructions, and other related details, see
ScreenWorks Software General Information on page 31.

ScreenWorks Software Version 5.1.4 Summary

The version 5.1.4 update incorporates the following changes:

Tracking ID Status Functional Area Description

SW51-25 Fixed General Random Refresh Issue in Plate Grid

SW51-135 Fixed General Opening a Non-standard File Causes an Error Loop

SW51-151 Fixed Peak Pro 2 Analysis After PeakPro 2 Analysis Window is Closed, PeakPro Remains

Active

SW51-153 Fixed Peak Pro 2 Analysis Baseline and Trigger Line Stay Visible After PeakPro 2 Analysis

is Closed

SW51-155 Fixed Peak Pro 2 Analysis When multiple data files were open, PeakPro analysis on one

data file caused the kinetic reduction values to display on the

grids of other data files

SW51-184 Fixed General Highlighting Wells During a Protocol Run Causes the Menu

Icons to Flicker

SW51-185 Fixed General Option to Wash Cell Reservoir is Disabled

SW51-188 Fixed General Pixelated Image Files

Table 2-1: Summary of version 5.1.4 changes

2
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Issues Addressed in ScreenWorks Software v5.1.4

The following explains the issues addressed and fixed in version 5.1.4.

Random Refresh Issue in Plate Grid

SW51-25

Fixed the issue that caused random refreshes in the plate grid.

Opening a Non-standard File Causes an Error Loop

SW51-135

Fixed the issue that caused an error loop (improper argument) when opening a non-standard
file.

After PeakPro 2 Analysis Window is Closed, PeakPro Remains Active

SW51-151

Fixed the issue that caused PeakPro to remain active after the PeakPro 2 analysis window was
closed.

Baseline and Trigger Line Stay Visible After PeakPro 2 Analysis is Closed

SW51-153

Fixed the issue that caused the baseline and trigger line stay visible even after the PeakPro 2
Analysis was closed.

Analysis of One Data File Launches Kinetic Reduction Values in Another Data
File

SW51-155

Fixed an issue that occurred when multiple data files were open, running the PeakPro analysis
on one data file caused the kinetic reduction values to display on the grids of other data files.

Highlighting Wells During a Protocol Run Causes the Menu Icons to Flicker

SW51-184

Fixed the issue that caused the menu icons to flicker when the user highlighted the entire plate
wells during a protocol run.

Option to Wash Cell Reservoir is Disabled

SW51-185

Fixed the issue that caused the wash cell reservoir option to be greyed out.

Pixelated Image Files

SW51-188

Fixed the issue that caused a protocol with saved images to randomly create pixelated TIF files
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Known Issues in ScreenWorks Software v5.1.4

The following explains the known issues in version 5.1.4.

Intermittent Application Crash During a Back-to-Back Read

SW51-182

Running protocols back-to-back may cause the ScreenWorks application to crash.

Workaround

Close the data files that remain opened after each run.
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Chapter 3: ScreenWorks Software Version 5.1.3 Release
Notes

The version 5.1.3 update is a minor release. Included are a summary and details of the changes
incorporated in this revision as compared to version 5.1.2, the last general release of the
software.

The following topics are included in this chapter:

ScreenWorks Software Version 5.1.3 Summary
Issues Addressed in ScreenWorks Software v5.1.3

For computer requirements, software update instructions, and other related details, see
ScreenWorks Software General Information on page 31.

ScreenWorks Software Version 5.1.3 Summary

The version 5.1.3 update incorporates the following changes:

Tracking ID Status Functional Area Description

SW51-180 Fixed General Intermittent Motion Subsystem Error in Automation Mode

Table 3-1: Summary of version 5.1.3 changes

Issues Addressed in ScreenWorks Software v5.1.3

The following explains the issues addressed and fixed in version 5.1.3.

Intermittent Motion Subsystem Error in Automation Mode

SW51-180

Fixed the issue in the firmware where in automation mode, the instrument intermittently reports
Motion Subsystem Error.

3
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Chapter 4: ScreenWorks Software Version 5.1.2 Release
Notes

The version 5.1.2 update is a minor release. Included are a summary and details of the changes
incorporated in this revision as compared to version 5.1.1, the last general release of the
software.

The following topics are included in this chapter:

ScreenWorks Software Version 5.1.2 Summary
Issues Addressed in ScreenWorks Software v5.1.2

For computer requirements, software update instructions, and other related details, see
ScreenWorks Software General Information on page 31.

ScreenWorks Software Version 5.1.2 Summary

The version 5.1.2 update incorporates the following changes:

Tracking ID Status Functional Area Description

SW51-19 Fixed General Instrument Restart Required After Software Crash

SW51-158 Fixed Yellow Plate Signal Test Yellow Plate Signal Test Uses Wrong Camera Mode

SW51-159 Fixed Protocols High Gain Lumi Protocol Switch to FL Causes Error

SW51-160 Fixed Protocols Yellow Plate Signal Test in FL and Then Pre-Stabilize for a Lumi

Protocol With High Gain Causes Error

SW51-163 Fixed Protocols Protocol With Dual Read Modes Causes Error

SW51-164 Fixed Protocols Protocol With Dual Read Modes Causes Incorrect Minimum

Interval Time

SW51-169 Fixed General Intermittent Software Crashes When Closing Several Data Tabs

SW51-170 Fixed Protocols Switching to a Lumi Protocol After Running a FL Protocol

Causes Error

SW51-171 Fixed Automation File Name Problem Using Barcodes in Automation Mode

Table 4-1: Summary of version 5.1.2 changes

Issues Addressed in ScreenWorks Software v5.1.2

The following explains the issues addressed and fixed in version 5.1.2.

Instrument Restart Required After Software Crash

SW51-19

Fixed the issue where a ScreenWorks software crash requires the instrument to be restarted.

Yellow Plate Signal Test Uses Wrong Camera Mode

SW51-158

Fixed the issue where the yellow plate signal test is set to use the default normal camera mode
but the signal test happens in the high speed camera mode.

4
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High Gain Lumi Protocol Switch to FL Causes Error

SW51-159

Fixed the issue where after running a luminescence protocol with the gain set to a value higher
than 128 and then switching to a fluorescence protocol, the software displays an error.

Yellow Plate Signal Test in FL and Then Pre-Stabilize for a Lumi Protocol With
High Gain Causes Error

SW51-160

Fixed the issue where after running the yellow plate signal test in fluorescence mode and then
manually pre-stabilizing the camera for a luminescence protocol with the gain set to higher than
128 results in a software error.

Protocol With Dual Read Modes Causes Error

SW51-163

Fixed the issue where running a dual read protocol with certain camera settings causes the
software to display an error.

Protocol With Dual Read Modes Causes Incorrect Minimum Interval Time

SW51-164

Fixed the issue where manually pre-stabilizing the camera for a protocol with dual read modes
causes incorrect minimum interval time.

Intermittent Software Crashes When Closing Several Data Tabs

SW51-169

Fixed the issue where selecting to close all files when several tabs are open intermittently
causes the software to crash.

Switching to a Lumi Protocol After Running a FL Protocol Causes Error

SW51-170

Fixed the issue where running a fluorescence protocol and then switching to a luminescence
protocol causes the software to display an error.

File Name Problem Using Barcodes in Automation Mode

SW51-171

Fixed the issue where running a protocol in automation mode with save images and with
barcodes enabled, produces incorrect image file names.
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Chapter 5: ScreenWorks Software Version 5.1.1 Release
Notes

The version 5.1.1 update is a minor release. Included are a summary and details of the changes
incorporated in this revision as compared to version 5.1, the last general release of the software.

The following topics are included in this chapter:

ScreenWorks Software Version 5.1.1 Summary
Issues Addressed in ScreenWorks Software v5.1.1 on page 15

For computer requirements, software update instructions, and other related details, see
ScreenWorks Software General Information on page 31.

ScreenWorks Software Version 5.1.1 Summary

The version 5.1.1 update incorporates the following changes:

Tracking ID Status Functional Area Description

SW51-156 Fixed Mode Switching Switching From Automation Mode to Manual Mode Causes

Error

Table 5-1: Summary of version 5.1.1 changes

Issues Addressed in ScreenWorks Software v5.1.1

The following explains the issues addressed and fixed in version 5.1.1.

Switching From Automation Mode to Manual Mode Causes Error

SW51-156

Fixed the issue where when the instrument is equipped to function in Automation mode,
switching from Automation mode to Manual mode causes a ScreenWorks software Motion
Control error.

5
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Chapter 6: ScreenWorks Software Version 5.1 Release
Notes

The version 5.1 update is a minor release. Included are a summary and details of the changes
incorporated in this revision as compared to version 5.0.1, the last general release of the
software.

The following topics are included in this chapter:

ScreenWorks Software Version 5.1 Summary
Modifications Made in ScreenWorks Software v5.1 on page 19
Issues Addressed in ScreenWorks Software v5.1 on page 20
Known Issues in ScreenWorks Software v5.1 on page 22

For computer requirements, software update instructions, and other related details, see
ScreenWorks Software General Information on page 31.

ScreenWorks Software Version 5.1 Summary

The version 5.1 update incorporates the following changes:

Tracking ID Status Functional Area Description

SW51-41 Modified Save Images Increased Maximum Saved Images Limit per Experiment

SW51-65 Modified Yellow Plate Signal Test Changed Default Camera Mode for Yellow Plate Signal Test

SW51-76 Modified Load Tip Position Improved Load Tips Position Protocol Setting

SW51-94 Modified Peak Pro 2.0 Analysis Use Normalized Data With Peak Pro 2.0 Analysis

SW51-97 Modified Peak Pro 2.0 Analysis Use Decimals for Trigger and Baseline in Peak Pro 2.0 Analysis

Dialog

SW51-101 Modified Peak Pro 2.0 Analysis Save Settings and Load Settings in Peak Pro 2.0 Analysis

Dialog

SW51-107 Modified Peak Pro 2.0 Analysis Set Individual Well Data Ranges in Peak Pro 2.0 Analysis Dialog

SW51-142 Modified Exporting Export Data With up to Four Decimal Places

SW51-144 Modified Peak Pro 2.0 Analysis Saved Settings Load Automatically in Peak Pro 2.0 Analysis

Dialog

SW51-145 Modified Peak Pro 2.0 Analysis Peak Pro 2.0 Statistics tab Opens With Peak Pro 2.0 Analysis

Dialog

SW51-11 Fixed Calibration Esc Makes Calibration Dialog Disappear Irretrievably

SW51-24 Fixed Multi-Well Graph, Well Labels Disappear When the Multi-Well Graph Resizes

SW51-40 Fixed Dispense Upper Limit of Dispense Speed not Validated

SW51-59 Fixed Well Graph Well Graph Marking Shows Hidden Well Instead of Displayed

Well

Table 6-1: Summary of version 5.1 changes

6
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Tracking ID Status Functional Area Description

SW51-60 Fixed Yellow Plate Signal Test 1536 Yellow Plate Test Signal Values Truncated

SW51-66 Fixed Peak Pro 2.0 Analysis Copy and Paste Issue for Peak Pro 2.0 Software Module Table

Data in Excel

SW51-90 Fixed Protocol Running Random "Unable to Aspirate" Error

SW51-91 Fixed File Saving Instrument Seems Frozen When Saving Large Data Files

SW51-98 Fixed Open Image Open Image File Menu Option Disappears After Running a

Protocol

SW51-103 Fixed File Saving Out of Memory Error After Opening and Closing Large Data

Files

SW51-104 Fixed Groups Adding Groups to a Large Data File Causes Crash

SW51-105 Fixed Peak Pro 2.0 Analysis Baseline Level Ignores Data Range Settings in Peak Pro 2.0

Analysis Dialog

SW51-111 Fixed Peak Pro 2.0 Analysis Peak Pro 1.0 Software Module License Expiration Breaks Peak

Pro 2.0 Software Module Export

SW51-114 Fixed Peak Pro 2.0 Analysis Issue With Normalized Data After Analysis in Peak Pro 2.0

Software Module

SW51-151 Known Issue Peak Pro 2.0 Analysis Peak Pro 2.0 Software Module Stays Active After Close

Table 6-1: Summary of version 5.1 changes (continued)
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Modifications Made in ScreenWorks Software v5.1

The following explains the modifications made in version 5.1.

Increased Maximum Saved Images Limit per Experiment

SW51-41

Protocols can be set to save up to 6,000 images per experiment.

Changed Default Camera Mode for Yellow Plate Signal Test

SW51-65

The Yellow Plate Signal Test default camera mode is now set to Normal.

Improved Load Tips Position Protocol Setting

SW51-76

When the Loads Tips Position setting is selected, and Source Plate 1 is used for tips, the setting
for aspirate automatically changes from Source Plate 1 to Source Plate 2.

Use Normalized Data With Peak Pro 2.0 Analysis

SW51-94

Peak Pro 2.0 Analysis is enhanced to run normalized data. Data normalization is a Corrections
option for Kinetic Reduction.

Use Decimals for Trigger and Baseline in Peak Pro 2.0 Analysis Dialog

SW51-97

The Trigger level and Baseline level in the Peak Pro 2.0 software module allow manual entry of
decimal values.

Save Settings and Load Settings in Peak Pro 2.0 Analysis Dialog

SW51-101

Peak Pro 2.0 Analysis dialog box settings can be saved and loaded for later analysis using the
added Save Settings and Load Settings buttons.

Set Individual Well Data Ranges in Peak Pro 2.0 Analysis Dialog

SW51-107

In the Peak Pro 2.0 Analysis dialog box, a data range can be set for individual wells.

Export Data With up to Four Decimal Places

SW51-142

A new Decimal Places field in all of the File Export tabs that allows you to specify 2, 3, or 4
decimal places for your export data. Your setting applies only if the selected number of decimal
places exist in the data.

Saved Settings Load Automatically in Peak Pro 2.0 Analysis Dialog

SW51-144

When you open a data file in the Peak Pro 2.0 software module that has saved settings, the
saved settings automatically load when the Peak Pro 2.0 Analysis dialog box opens.
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Peak Pro 2.0 Statistics tab Opens With Peak Pro 2.0 Analysis Dialog

SW51-145

When you open the Peak Pro 2.0 Analysis dialog box, the Peak Pro 2.0 Statistic tab is active.
When you close the Peak Pro 2.0 Analysis dialog box, the Kinetic Reduction tab is active.

Issues Addressed in ScreenWorks Software v5.1

The following explains the issues addressed and fixed in version 5.1.

Esc Makes Calibration Dialog Disappear Irretrievably

SW51-11

Fixed the issue where pressing the Esc key to close the Calibration dialog box makes it
unusable again until the software is restarted.

Well Labels Disappear When the Multi-Well Graph Resizes

SW51-24

Fixed the issue where resizing the multi-well graph window causes the well labels to change to
boldface and randomly disappear.

Upper Limit of Dispense Speed not Validated

SW51-40

Fixed the issue where when an out of range dispense speed is specified, the dispense speed is
not validated before a protocol runs, which requires an instrument reset during the run.

Well Graph Marking Shows Hidden Well Instead of Displayed Well

SW51-59

Fixed the issue where when multiple wells are analyzed, even though only one well is in focus,
and clicking a spot on the graph shows the details of a hidden well.

1536 Yellow Plate Test Signal Values Truncated

SW51-60

Fixed the issue where the signal values for a 1536 Yellow Plate Test would truncate causing
rows AA through AF to go missing.

Copy and Paste Issue for Peak Pro 2.0 Software Module Table Data in Excel

SW51-66

Fixed the issue where copying in the Peak Pro 2.0 software module by clicking the Copy Table
Data to Clipboard button and pasting it to Excel, shifts the values of CTD @90% to the next
column.

Random "Unable to Aspirate" Error

SW51-90

Fixed the issue where running a protocol intermittently displays an error message that the
instrument is unable to aspirate.
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Instrument Seems Frozen When Saving Large Data Files

SW51-91

Fixed the issue where when saving a large data file, the instrument remains busy without any
indication of remaining time and appears frozen.

Open Image File Menu Option Disappears After Running a Protocol

SW51-98

Fixed the issue where after running a protocol, the Open Image option in the File menu
disappears.

Out of Memory Error After Opening and Closing Large Data Files

SW51-103

Fixed the issue where after opening and closing a large data file with 6,000 reads, an out of
memory error message displays.

Note: When data files from older versions of ScreenWorks Software are opened and
re-saved in ScreenWorks Software Version 5.1, they can no longer be opened in
previous ScreenWorks Software versions, including ScreenWorks Software Version 5.0.
Before saving the data file in the 5.1 software format, a backup copy of the data file is
automatically saved in its original software format.

Adding Groups to a Large Data File Causes Crash

SW51-104

Fixed the issue where adding groups to a large data file of a 1536 plate with 6,000 reads causes
intermittent software crashes.

Baseline Level Ignores Data Range Settings in Peak Pro 2.0 Analysis Dialog

SW51-105

Fixed the issue where the Baseline level always uses the full data range, regardless of the Data
range settings in the Peak Pro 2.0 Analysis dialog box.

Peak Pro 1.0 Software Module License Expiration Breaks Peak Pro 2.0
Software Module Export

SW51-111

Fixed the issue where when the Peak Pro 1.0 software module license expires, when exporting
statistics for Peak Pro 2.0 software module, the kinetic reduction types menu options in the
Compute list are missing.

Issue With Normalized Data After Analysis in Peak Pro 2.0 Software Module

SW51-114

Fixed the issue where when after a set of wells are analyzed in the Peak Pro 2.0 software
module and corrections to normalize data are applied, using the normalized data with the
default setting results in the loss of the baseline level and the trigger line.
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Known Issues in ScreenWorks Software v5.1

The following explains the known issues in version 5.1.

Peak Pro 2.0 Software Module Stays Active After Close

SW51-151

If the Peak Pro 2.0 software module has been opened and closed, clicking on the well grid can
cause the Peak Pro 2.0 software module baseline and other markers to show up on the graph.

Workaround:

Close and re-open the data file.
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Chapter 7: ScreenWorks Software Version 5.0.1 Release
Notes

The version 5.0.1 update is a minor release. Included are a summary and details of the changes
incorporated in this revision as compared to version 5.0, the last general release of the
software.

The following topics are included in this chapter:

ScreenWorks Software Version 5.0.1 Summary
Modifications Made in ScreenWorks Software v5.0.1 on page 25
Issues Addressed in ScreenWorks Software v5.0.1 on page 25

For computer requirements, software update instructions, and other related details, see
ScreenWorks Software General Information on page 31.

ScreenWorks Software Version 5.0.1 Summary

The version 5.0.1 update incorporates the following changes:

Tracking ID Status Functional Area Description

SW51-23 Modified Peak Pro 2.0

Analysis

Peak Pro 2.0 Software Module Displays Kinetic Reduction Type

SW51-29 Modified Peak Pro 2.0

Analysis

Peak Pro 2.0 Analysis Dialog Dynamic Threshold Settings

Improvements

SW51-48 Modified Peak Pro 2.0

Analysis

Peak Pro 2.0 Software Module Auto Noise Rejection Improvements

SW51-17 Fixed Plate Grid View Well Saturation Warning Text Overlapped Other Text

SW51-30 Fixed Peak Pro 2.0

Analysis

Peak Pro 2.0 Software Module Calculated CTD90 and Peak Decay

Time for Very Wide Peaks Wrong

SW51-31 Fixed Yellow Plate Signal

Test

Camera Exposure Setting Issues After a Yellow Plate Signal Test

SW51-51 Fixed Groups Adding Groups With Certain Settings Caused Crash

SW51-55 Fixed Peak Pro 2.0

Analysis

Peak Pro 2.0 Software Module Calculated Rise Time Values for

Some Wells Wrong

SW51-58 Fixed Peak Pro 2.0

Analysis

Peak Pro 2.0 Software Module Randomly Crashed

SW51-61 Fixed Peak Pro 2.0

Analysis

Peak Pro 2.0 Software Module Displayed Inconsistent Peak Spacing

Values

SW51-64 Fixed Peak Pro 2.0

Analysis

Removing Groups From Analyzed Data in Peak Pro 2.0 Software

Module Caused Crashes

SW51-70 Fixed Tools Save Error Log Broken

Table 7-1: Summary of version 5.0.1 changes

7
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Tracking ID Status Functional Area Description

SW51-79 Fixed ICCD

Luminescence

Mode

On ICCD Instruments, Gate Setting for Luminescence Mode was

Wrong

Table 7-1: Summary of version 5.0.1 changes (continued)
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Modifications Made in ScreenWorks Software v5.0.1

The following explains the modifications made in version 5.0.1.

Peak Pro 2.0 Software Module Displays Kinetic Reduction Type

SW51-23

To be consistent with the Peak Pro 1.0 software module, the selected Kinetic Reduction type in
the Peak Pro 2.0 software module displays above the Plate Grid View next to the icon button.

Peak Pro 2.0 Analysis Dialog Dynamic Threshold Settings Improvements

SW51-29

In the Peak Pro 2.0 software module, there is a new Apply to all wells check box for the
Dynamic threshold settings.

Peak Pro 2.0 Software Module Auto Noise Rejection Improvements

SW51-48

In the Peak Pro 2.0 software module, a new Auto Noise Rejection algorithm improves noise
elimination.

Issues Addressed in ScreenWorks Software v5.0.1

The following explains the issues addressed and fixed in version 5.0.1.

Well Saturation Warning Text Overlapped Other Text

SW51-17

Fixed the issue where the well saturation warning message on the top of the plate grid covered
the text Max Value RFU. It also cut off on the right side, displaying an incomplete sentence.

Peak Pro 2.0 Software Module Calculated CTD90 and Peak Decay Time for
Very Wide Peaks Wrong

SW51-30

Fixed the issue where the Peak Pro 2.0 software module calculated CTD90 and Peak Decay
time values wrong.

Camera Exposure Setting Issues After a Yellow Plate Signal Test

SW51-31

Fixed the issue where after running the Yellow Plate Signal Test, followed by a manual camera
stabilization, and then a protocol, the stabilization still used the last exposure settings from the
signal test, rather than the settings in the protocol.

Adding Groups With Certain Settings Caused Crash

SW51-51

Fixed the issue where adding a new group with certain values in number of rows or columns
caused a crash.
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Peak Pro 2.0 Software Module Calculated Rise Time Values for Some Wells
Wrong

SW51-55

Fixed the issue where the Peak Pro 2.0 software module calculated Rise Time values for some
wells wrong.

Peak Pro 2.0 Software Module Randomly Crashed

SW51-58

Fixed the issue where Peak Pro 2.0 software module randomly crashed when changing
settings.

Peak Pro 2.0 Software Module Displayed Inconsistent Peak Spacing Values

SW51-61

Fixed the issue where the Peak Spacing values selected in the Peak Pro 2.0 Analysis
Configuration tab displayed differently in the Statistics table and the Plate Grid View.

Removing Groups From Analyzed Data in Peak Pro 2.0 Software Module
Caused Crashes

SW51-64

Fixed the issue where after using the Peak Pro 2.0 software module, deleting or modifying data
caused crashes.

Save Error Log Broken

SW51-70

Fixed the issue where the Save error log option produced a blank file.

On ICCD Instruments, Gate Setting for Luminescence Mode was Wrong

SW51-79

Fixed the issue where, on ICCD instruments, the gate setting for Luminescence mode
incorrectly locked at 6% when it should have been 100%.
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Chapter 8: ScreenWorks Software Version 5.0 Release
Notes

The version 5.0 update is a major release. Included are a summary and details of the changes
incorporated in this revision as compared to version 4.2.1, the last general release of the
software.

The following topics are included in this chapter:

ScreenWorks Software Version 5.0 Summary
New in ScreenWorks Software v5.0 on page 28
Modifications Made in ScreenWorks Software v5.0 on page 28
Issues Addressed in ScreenWorks Software v5.0 on page 28

For computer requirements, software update instructions, and other related details, see
ScreenWorks Software General Information on page 31.

ScreenWorks Software Version 5.0 Summary

The version 5.0 update incorporates the following changes:

Tracking ID Status Functional Area Description

TET-15 New Read Mode Added the Ability to Sample up to 50 Points per Cardiomyocyte

Calcium Peak

TET-16 New Read Mode Added the Ability to Capture up to 6,000 Samples per

Experiment

TET-84 New Camera Added High Speed Camera Support With Continuous

Stabilization

TET-111 New Data Analysis Added ScreenWorks Peak Pro Software Version 2.0

TET-7 Modified Protocols Simplified Drag and Drop Steps in Protocols

TET-24 Modified Peak Pro 1 Kinetic

Reduction

Alphabetized List of Standard Deviations in Peak Pro 1.0

Software Module

TET-6 Fixed Analysis Tab Slow Screen Refresh With Large Data Files

TET-13 Fixed Group Statistics Graph

Tab

Missing Graphs in Group Statistics

TET-64 Fixed Signal Test and

Protocol Test

No Screen Refresh in Signal Test and Protocol Test

TET-80 Fixed Protocols Stopping a Running Protocol Causes Software Crash

TET-104 Fixed System Memory Out of Memory Error

Table 8-1: Summary of version 5.0 changes

8
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New in ScreenWorks Software v5.0

The following new features are included in version 5.0.

Added the Ability to Sample up to 50 Points per Cardiomyocyte Calcium Peak

TET-15

Added the ability for ScreenWorks Software to provide up to 50 sample points per peak for a
cardiomyocyte beating at 120 beats per minute or two beats per second.

Added the Ability to Capture up to 6,000 Samples per Experiment

TET-16

Added the ability for ScreenWorks Software to capture up to 6,000 samples per experiment.
The HS EMCCD camera in HighSpeed mode captures 6,000 samples in 60 seconds.

Added High Speed Camera Support With Continuous Stabilization

TET-84

Added high-speed and high-sensitivity camera support (sampling rate up to 100 Hz) with
continuous camera stabilization.

Added ScreenWorks Peak Pro Software Version 2.0

TET-111

New advanced peak detection and event characterization measurements and analysis
functionality for high-speed and high-sensitivity data analysis and data export. Requires the
purchase of a separate software module license.

Modifications Made in ScreenWorks Software v5.0

The following modifications were made in version 5.0.

Simplified Drag and Drop Steps in Protocols

TET-7

In protocol editor, a new step icon automatically gets placed at the end of the list of protocol
steps, by dragging the new step icon anywhere on the work area.

Alphabetized List of Standard Deviations in Peak Pro 1.0 Software Module

TET-24

The list of Standard Deviation options in Peak Pro 1.0 software module is now alphabetized.

Issues Addressed in ScreenWorks Software v5.0

The following explains the issues addressed and fixed in version 5.0.

Slow Screen Refresh With Large Data Files

TET-6

Fixed the issue where, in the Analysis tab, clicking in a well on the plate map causes a slow
screen refresh.
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Missing Graphs in Group Statistics

TET-13

Fixed the issue where, in the Group Statistics Graph tab, after a data acquisition, you must
refresh the Group Statistics Graph window to view the graph.

No Screen Refresh in Signal Test and Protocol Test

TET-64

Fixed the issue where during signal test or protocol signal test, when the cursor was left
positioned over the dialog box, the screen would not refresh.

Stopping a Running Protocol Causes Software Crash

TET-80

Fixed the issue where clicking Stop during a protocol run caused the software to freeze or
crash.

Out of Memory Error

TET-104

Fixed the issue where if multiple large data files that contained image files were opened, the out
of memory message displayed, and the ScreenWorks Software had to be restarted.
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Chapter 9: ScreenWorks Software General Information

Use ScreenWorks System Control to define and run experimental protocols, and control the
FLIPR® Penta High-Throughput Cellular Screening System.

The following topics are included in this chapter:

Computer System Requirements
Installing ScreenWorks Software
Activating the ScreenWorks Peak Pro License on page 32
Uninstalling ScreenWorks Software on page 32
Starting the Software on page 33
Understanding Online Mode vs. Offline Mode on page 33
Obtaining Support on page 34

Computer System Requirements

The ScreenWorks Software version 5.1.2 has the following computer system specifications for
use with the FLIPR Penta instrument:

Item Description

CPU 2.5 GHz, quad processor or faster

Operating system Windows 10, 64-bit

Memory 16 GB RAM

4 GB RAM minimum

Data Connection 10/100 Ethernet port

Storage 500 GB hard drive

Display 27 inches, 2560 x 1440 resolution maximum, Custom scaling setting not to exceed

107%

Computer Specifications

Note: Do not change the Display settings to those that exceed the stated specifications.

Installing ScreenWorks Software

The installer uninstalls the old software version as long as it is the same major release (5.x to
5.x+x). If you update to the next major release (4.x to 5.x), you must manually uninstall the old
software. See Uninstalling ScreenWorks Software on page 32.

To install the software:

1. Double-click the ScreenWorks_x.x.exe ScreenWorks Software installation file to display the
Welcome to the ScreenWorks Setup Wizard.

2. Click Next to display the License Agreement page.
3. Select the I Accept the Terms of the License Agreement check box.
4. Click Next to display the Online/Offline Mode page.

9
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5. Select a default mode in which to start the software:
Select Online to have the software look for a connected instrument when the software
starts.
Select Offline to have the software not look for a connected instrument.

6. Click Next to display the Destination Folder page.
7. Note the default installation directory. To change the installation directory, click Change,

navigate to the destination directory, then click OK.
8. Click Next to display the Select Program Folder page.
9. Leave the default Program Folder settings and select the Anyone Who Uses This

Computer check box to make the software available to all users on the FLIPR Penta System
host computer.

10. Click Next to display the Configuring the ScreenWorks Installation page.
11. Click Next to start the installation.
12. When the Completing the Installation Process page displays, click Finish.

Uninstalling ScreenWorks Software

To uninstall the ScreenWorks Software:

1. Open the Control Panel.
2. Depending on the Windows operating system:

Windows 7 - Click Add or Remove Programs
Windows 10 - Click Programs and Features

3. Select ScreenWorks.
4. Click Remove or Uninstall.
5. Follow the on-screen instructions to finish the software removal.

Activating the ScreenWorks Peak Pro License

The ScreenWorks® Peak Pro™ Software is license protected. The software license activation
allows the Peak Pro analysis functionality after the trial period expires. The following Peak Pro
analysis licenses are available for purchase:

ScreenWorks Peak Pro Software version 1.0 adds additional Kinetic Reduction
Configuration types.
ScreenWorks Peak Pro Software version 2.0 adds a new Peak Pro 2.0 Analysis dialog and
support for high-speed and high-sensitivity data.

Note: There is a 14-day Peak Pro trial usage option in the Help menu. When the trial
period expires, the Peak Pro 1.0 analysis functionality disappears, the Peak Pro 2.0
analysis functionality disables, and the Help menu trial option is inactive. The rest of the
ScreenWorks Software remains functional.

To activate the ScreenWorks Peak Pro Software license:

1. Start the ScreenWorks Software.
2. Select the Help tab and click Software License.
3. If you did not start the 14-day Peak Pro Software trial, either start the 14-day Peak Pro

Software trial or enter the product key. After the trial expires, you can only enter the
software license product key. Click Yes.
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4. If the computer has internet access, in the Product Key field, enter the product key and click
Activate Online. Then follow the on-screen instructions.
If the computer does not have Internet access, click Activate Offline and follow the on-
screen instructions. You need:

Product key
A computer with Internet access
A USB to transfer files between the computers

5. Restart the ScreenWorks Software to finish the license activation.

Starting the Software

You can start the ScreenWorks Software with or without an attached instrument. When no
instrument is connected, you are working offline and you cannot acquire data. As long as you
can open an existing data file, you can use the software offline.

To start the software under normal, online conditions, wait for the connected instrument to

complete its startup sequence, and then double-click the ScreenWorks icon on your
desktop.
To start the software from the Windows Start menu, click Start > All Programs > Molecular
Devices > ScreenWorks 5.1.

Understanding Online Mode vs. Offline Mode

The software has two startup modes:

Online - The software is connected to the instrument.

Offline - The software is disconnected from the instrument.

You determine the default startup mode when you install the software. You must reinstall the
software to change the default startup mode. Regardless of the startup mode, the pipettor head
and tip washer type must always match.

Note: To allow the selection of either mode when you generate protocols, you must
install the software to default to Offline mode.

To switch modes: click the Instrument menu and select either Go Online or Go Offline. This
does not change the default startup mode.

About Online Mode

When the ScreenWorks Software starts in Online mode, the software checks for instrument
connections. A message displays if no connections are sensed. Check the connections and
attempt to connect again or select to run the software in Offline mode.

Create new protocols in Online mode.

The software flags the protocols you create in Offline mode with instrument hardware settings
that do not match current instrument hardware. You must change the hardware settings to
match the protocol before you can run the protocol.

When the software starts in Online mode and connects to the instrument, the default installation
configuration file is overwritten using the current instrument settings and plate library
information.
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If you work in Online mode and then switch to Offline mode, the instrument setup configuration
is remembered as the last setting.

About Offline Mode

When the ScreenWorks Software starts in Offline mode, you can configure the following
hardware options:

Camera Type
Pipettor Format

When the default ScreenWorks Software start is set to Online mode and no instrument
connection registers, a message displays. You can check the connections and attempt to
connect again in Online mode, or you can select to run the software in Offline mode.

Obtaining Support

Molecular Devices is a leading worldwide manufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products and to
fully supporting our customers with the highest level of technical service.

Our Support website—https://support.moleculardevices.com/—describes the support options
offered by Molecular Devices, including service plans and professional services. It also has a
link to the Molecular Devices Knowledge Base, which contains documentation, technical notes,
software upgrades, safety data sheets, and other resources. If you still need assistance, you can
submit a request to Molecular Devices Technical Support.

Please have your instrument serial number or Work Order number, and your software version
number available when you call.

WARNING! BIOHAZARD. It is your responsibility to decontaminate components of
the instrument before you return parts to Molecular Devices for repair. Molecular
Devices does not accept items that have not been decontaminated where it is
applicable to do so. If parts are returned, they must be enclosed in a sealed plastic bag
stating that the contents are safe to handle and are not contaminated.

http://www.moleculardevices.com/service-support
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